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How Do I Use THe new CreaTe a GrapH

GettinG Started . . .

l	Begin by logging on to the Internet and going to http://nces.ed.gov/nceskids/createagraph if 
you are not already there. 

l	A screen will appear with several options for what type of graph you want to build. If you are 
unsure of which type of graph you should use, read the “How Do I choose Which Graph to 
Use” section of the tutorial. Then select the appropriate graph by clicking the icon. 

l	Once you have selected your graph, take a moment to read the Help menu on the left side of 
your screen. It will give you some tips about making your graph. 

“deSiGn”

Once you have selected which type of graph you want to use, you are asked to select several dif-
ferent settings for the layout of your graph. You can always go back and change, so try different 
options to see which works best. 

l	For line graphs and area graphs, you will be asked to select a background color for your 
graph, the color you want the grid lines to be, the number of gridlines you want (how many 
segments do you want the y-axis separated into), whether you want the graph to be 2-dimen-
sional or 3-dimensional, and where you want the legend for your graph to be. 

l	For bar graphs, you will be asked to select the same things as above, but you will also need to 
select what kind of bars you want to have. 

l	For pie charts, you will need to select what kind of filler you want the slices to have in addi-
tion to the general information. Notice you do not have to select information about grid lines, 
because a pie chart has no x or y-axis. 

l	For X-Y plots, you will need to select which type of plot you wish to have in addition to the 
general information. 

“data”

l	After you have filled in all of the information on the Design Tab, you can select the Data Tab 
on the right side of the screen. Again, take a moment to read the help menu. It will explain 
each of the fields you are being asked to fill in. 

l	Give your graph a title and identify the source of your data. If your graph has axes, you will 
need to label them. 

l	Next you will need to select how many data points you are going to enter and whether you 
are entering one or more groups of data. 

l	You will select the colors for your bars/lines/slices as well as the shape, size, and color of the 
points for line graphs and x-y plots. 

l	After this, you need to enter your data and give each data a label that will appear along the 
x-axis or, of you are creating a pie chart, in the legend. 

http://nces.ed.gov/nceskids/createagraph
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l	Finally, on this page you will be asked to select minimum and maximum values for the axes. 
They will be divided into equal segments depending on how many grid lines you selected on 
the previous page. 

l	Once you have entered all of the information, you need to select the Labels tab on the right of 
your screen. 

“LabeLS”

l	Now that you have all of your data entered, it is time to choose how you wish to label the 
data on your graph. Again, you should read the Help menu first. 

l	Begin by choosing whether you want to show data labels or not. Then you can choose the 
position, font, and color of your data labels. The data labels are those that directly label each 
piece of data. (For example, bars in bar graph or slices in a pie char.) 

l	Next, you can choose the color and size for the other text on your graph. (For example, Title, 
axis labels, Legend, etc.) 

l	Finally, you should select the font you want all of your labels to appear in. 

l	After you have completed all of the information, you can click on the Preview tab on the right 
side of the screen. This will allow you to see what your graph looks like. If you want to change 
anything, just select the appropriate tab and change the information. You can preview the 
graph after every change you make until you are satisfied with the final product. 

l	Once you are satisfied, select the Print/Save Tab. 

“Print/Save”

l	Now that your graph is complete, you can print, save, and email your graph, or you can start 
a new graph. 

l	If you wish to erase your graph or start a new one, select the action under Project Tools. 

l	If you wish to print your graph, simply select I. 

l	In order to save your graph, click on I and choose what format you want to save it in and 
where you want to save the graph. 

l	If you wish to email the graph to yourself or someone else, simply type in the email address 
and click Send. You will be able to make changes to the graph from the emailed link. 
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How Do I CHoose wHICH Type of GrapH To Use?

when to Use . . .

. . . a line graph. 

Line graphs are used to track changes over short and long periods of time. When smaller chang-
es exist, line graphs are better to use than bar graphs. Line graphs can also be sued to compare 
changes over the same period of time for more than one group.

. . . a pie Chart.

Pie charts are best to use when you are trying to compare parts of a whole. They do not show 
changes over time.

. . . a bar Graph. 

Bar graphs are used to compare things between different groups or to track changes over time. 
However, when trying to measure change over time, bar graphs are best when the changes are 
larger.

. . . an area Graph.

Area graphs are very similar to line graphs. They can be used to track changes over time for one 
or more groups. Area graphs are good to use when you are tracking the changes in two or more 
related groups that make up one whole category (for example public and private groups).

. . . an X-y plot.

X-Y plots are used to determine relationships between the two different things. The x-axis is 
used to measure one event (or variable) and the y-axis is used to measure the other. If both 
variables increase at the same time, they have a positive relationship. If one variable decreases 
while the other increases, they have a negative relationship. Sometimes the variables don’t fol-
low any pattern and have no relationship. 
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bUIlDInG bar GrapHs

Bar graphs can be used to show how something changes over time or to compare different 
times. Bar graphs are good for plotting data that spans many years (or days, weeks . . .), has 
really big changes from year to year (or day to day . . .), or they can be used for comparing dif-
ferent items in a related category (for example: comparing something between different states). 
The following pages describe the different parts of a bar graph.

the titLe

The title offers a short explanation of what is in your graph. This helps the reader identify what 
they are about to look at. It can be creative or simple as long as it tells what is in the graph. The 
title of this graph tells the reader that the graph contains information about the states with the 
most elementary and secondary schools, and how many schools each of those states has.

the LeGend

The legend tells us what each bar represents. Just like on a map, the legend helps the reader 
understand what they are looking at. This legend tells us that the blue bars represent elemen-
tary and secondary schools. If a graph has more than one color bar, the legend will have more 
than one entry.
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the Source

The source explains where you found the information that is in your graph. It is important to 
give credit to those who collected your data! In this graph, the source tells us that we found our 
information from the NCES Common Core of Data.

X-aXiS

Bar graphs have an x-axis and a y-axis. In most bar graphs, like the one above, the x-axis 
runs horizontally (flat). Sometimes bar graphs are made so that the bars are sidewise like in 
the graph below. Then the x-axis has numbers representing different time periods or names of 
things being compared. In these graphs, the x-axis has names of states.

Y-aXiS

In most bar graphs, like the one above, the y-axis runs vertically (us and down). Sometimes bar 
graphs are made so that the bars are sideways like in the graph to the left. Then the y-axis is 
horizontal (flat). Typically, the y-axis has numbers for the amount of stuff being measured. The 
y-axis usually starts counting at 0 and can be divided into as many equal parts as you want to. 
In these bar graphs, the y-axis is measuring the number of schools. 
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the data

The most important part of your graph is the information, or data, it contains. Bar graphs can 
present data in many ways and can present more than one group of data at a time. The graph 
on the left is a regular bar graph with one group of data. The center graph has two groups of 
data that are stacked. The graph on the right is another graph with two groups of data, but they 
are presented side by side instead of stacked. 
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learnInG lIne GrapHs

Line graphs can be used to show how something changes over time. Line graphs are good for 
plotting data that has peaks (ups) and valleys (downs), or that was collected in a short time pe-
riod. The following pages describe the different parts of a line graph. 

the titLe

The title offers a short explanation of what is in your graph. This helps the reader identify what 
they are about to look at. It can be creative or simple as long as it tells what is in the graph. 
The title of this graph tells the reader that the graph contains information about the changes in 
money spent on students of elementary and secondary schools from 1961 to 2002. 

the LeGend

The legend tells what each line represents. Just like on a map, the legend helps the reader un-
derstand what they are looking at. This legend tells us that the green line represents the actual 
dollar amount spent on each child and the purple line represents the amount spent when adjust-
ed for inflation.

the Source

The source explains where you found the information that is in your graph. It is important to 
give credit to those who collected your data! In this graph, the source tells us that we found our 
information from NCES. 
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Y-aXiS

In line graphs, the y-axis runs vertically (up and down). Typically, the y-axis has numbers for the 
amount of stuff being measured. The y-axis usually starts counting at 0 and can be divided into 
as many equal parts as you want to. In this line graph, the y-axis is measuring the amount of 
money spent on individual students for public education.

the data 

The most important part of your graph is the information, or data, it contains. Line graphs can 
present more than one group of data at a time. In this graph, two sets of data are presented. 

X-aXiS 

In line graphs, like the one above, the x-axis runs horizontally (flat). Typically, the x-axis has 
numbers representing different time periods or names of things being compared. In this line 
graph, the x-axis measured different school years. 
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perfeCTInG pIe CHarTs

Pie charts can be used to show percentages of a whole, and represents percentages at a set 
point in time. Unlike bar graphs and line graphs, pie charts do not show changes over time. The 
following pages describe the different parts of a pie chart.

the titLe

The title offers a short explanation of what is in your graph. This helps the reader identify what 
they are about to look at. It can be creative or simple as long as it tells what is in the chart. The 
title of this chart tells the reader that the graph contains information about how money is spent 
for public education for the average student. 

the LeGend

The legend tells what each slice represents. Just like on a map, the legend helps the reader 
understand what they are looking at. This legend tells us that the green slice represents money 
spent on instruction, the blue slice represents money spent on support services, and the orange 
slice represents money spent on non-instruction activities.

the Source

The source explains where you found the information that is in your graph. It is important to 
give credit to those who collected your data! In this graph, the source tells us that we found our 
information from the NCES Common Core of Data. 
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the data

The most important part of your chart is the information, or data, it contains. Pie charts repre-
sent data as part of 100 (a percentage). Each slice represents a different piece of data. 
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analysInG area GrapHs

Like line graphs, area graphs can be used to show how something changes over time. They can 
be used when you’re plotting data that has peaks (ups) and valleys (downs), or that was collect-
ed in a short time period. The following pages describe the different parts of an area graph. 

 the titLe

The title offers a short explanation of what is in your graph. This helps the reader identify what 
they are about to look at. It can be creative or simple as long as it tells what is in the graph. 
The title of this graph tells the reader that the graph contains information about the changes in 
enrollment of elementary and secondary schools from 1970 to 2000. 

the LeGend

The legend tells what each shaded area represents. Just like on a map, the legend helps the 
reader understand what they are looking at. This legend tells us that the blue area represents 
enrollment in public schools and the yellow area represents enrollment in private schools. 

the Source

The source explains where you found the information that is in your graph. It is important to 
give credit to those who collected your data! In this graph, the source tells us that we found our 
information from the NCES. 
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Y-aXiS

In area graphs, the y-axis runs vertically (up and down). Typically, the y-axis has numbers for 
the amount of stuff being measured. The y-axis usually starts counting at 0 and can be divided 
into as many equal parts as you want to. In this area graph, the y-axis is measuring the number 
of students enrolled in public and private schools.

the data 

The most important part of your graph is the information, or data, it contains. Area graphs can 
present more than one group of data at a time. In this graph, two sets of data are presented. 

X-aXiS 

In area graphs, like the one above, the x-axis runs horizontally (flat). Typically, the x-axis has 
numbers representing different time periods or names of things being compared. In this area 
graph, the x-axis measures different school years.



Create a GrapH tUtorIal | 15

eXamInInG X-y (sCaTTer) ploTs

X-Y plots, or scatter plots, can be used to see if one event affects another event. For example, if 
you spend more hours studying, will you get better grades? The following pages describe the dif-
ferent parts of an x-y plot. 

the titLe

The title offers a short explanation of what is in your graph. This helps the reader identify what 
they are about to look at. It can be creative or simple as long as it tells what is in the graph. 
The title of this graph tells the reader that the graph contains information about the difference in 
money spent on students of elementary and secondary schools from different countries. 

the LeGend

The legend tells what each point represents. Just like on a map, the legend helps the reader un-
derstand what they are looking at. Each of the colors in this legend represents a different coun-
try.

the Source

The source explains where you found the information that is in your graph. It is important to 
give credit to those who collected your data! In this graph, the source tells us that we found our 
information from the Organization for Economic Cooperation and Development. 
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Y-aXiS

In x-y plots, the y-axis runs vertically (up and down). Typically, the y-axis has numbers for the 
amount of stuff being measured. The y-axis usually starts counting at 0 and can be divided into 
as many equal parts as you want to. In this line graph, the y-axis is measuring the Gross Do-
mestic Product (GDP) of each country. 

the data 

The most important part of your graph is the information, or data, it contains. Line graphs can 
present more than one group of data at a time. In this graph, two sets of data are presented. 

X-aXiS 

In x-y plots, like the one above, the x-axis runs horizontally (flat). Typically, the x-axis has num-
bers representing different time periods or names of things being measured. In this plot, the x-
axis measures the amount of money spent by a country on elementary and secondary education 
per child.
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wHaT are InDepenDenT anD DepenDenT VarIables? 

QueStion: What’S a variabLe?

Answer: A variable is an object, event, idea, feeling, time period, or any other type of 
category you are trying to measure. There are two types of variables-independent and 
dependent. 

QueStion: What’S an indePendent variabLe? 

Answer: An independent variable is exactly what it sounds like. It is a variable that 
stands alone and isn’t changed by the other variables you are trying to measure. For 
example, someone’s age might be an independent variable. Other factors (such as what 
they eat, how much they go to school, how much television they watch) aren’t going to 
change a person’s age. In fact, when you are looking for some kind of relationship be-
tween variables you are trying to see if the independent variable causes some kind of 
change in the other variables, or dependent variables. 

QueStion: What’S a dePendent variabLe? 

Answer: Just like an independent variable, a dependent variable is exactly what it 
sounds like. It is something that depends on other factors. For example, a test score 
could be a dependent variable because it could change depending on several factors 
such as how much you studied, how much sleep you got the night before you took the 
test, or even how hungry you were when you took it. Usually when you are looking for 
a relationship between two things you are trying to find out what makes the dependent 
variable change the way it does. 

Many people have trouble remembering which is the independent variable and which 
is the dependent variable. An easy way to remember is to insert the names of the two 
variables you are using in this sentence in they way that makes the most sense. Then 
you can figure out which is the independent variable and which is the dependent vari-
able: 

(Independent variable) causes a change in (Dependent Variable) and it isn’t possible 
that (Dependent Variable) could cause a change in (Independent Variable).

For eXamPLe: 

(Time Spent Studying) causes a change in (Test Score) and it isn’t possible that (Test Score) 
could cause a change in (Time Spent Studying).

We see that “Time Spent Studying” must be the independent variable and “Test Score” must be 
the dependent variable because the sentence doesn’t make sense the other way around.
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Fun GraphinG ExErcisEs!

Learn about Your SchooL!

l	Go to http://nces.ed.gov/nceskids/tools/ and select whether you go to a private or public 
school by clicking on the correct category. 

l	Click on your state and then click on the letter your city begins with. Find your city and click 
on it. Then scroll through the list of schools until you find yours. Click on your school. 

l	Look at Enrollment by race/ethnicity and see how it is represented in a pie chart. 

l	Write down the information under Enrollment by Grade, recording how many students are in 
each grade. 

l	Then go to the Create-A-Graph and use the information you recorded to make your own graph 
showing how many students are in each grade at your school. What is the best graph to use? 
Try using different kinds of graphs.

http://nces.ed.gov/nceskids/tools
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